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Abstract: The use of unmanned aerial vehicles (UAVs) is growing rapidly across many civil application 

domains including real-time monitoring, providing wireless coverage, remote sensing, search and rescue, 

delivery of goods, security and surveillance, precision agriculture, and civil infrastructure inspection. 

Smart UAVs are the next big revolution in UAV technology promising to provide new opportunities in 

different applications, especially in civil infrastructure in terms of reduced risks and lower cost. Civil 

infrastructure is expected to dominate the more than $45 Billion market value of UAV usage. Unmanned 

aerial vehicles often are employed in civil engineering for a variety of purposes. Drones as instruments that 

improve communication between construction participants, improve site safety, use topographic 

measurements of huge regions, and produce buildings aerial surveying, bridges, roads, and highways 

utilising principles of aerial photogrammetry, saving project time and costs, and so on. 
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I. INTRODUCTION 

Aerial survey is a method of collecting geomatics or other imagery by using airplanes, helicopters, UAVs, balloons, or 

other aerial methods or an aerial survey is a process of image acquisition of a surface from an elevated position. 

Nowadays specialists widely use manned and unmanned aerial vehicles (UAV) to take photographs of the surface. High 

spatial resolution and good quality images display the real situation on the surface. UAVs can be used in many civil 

applications due to their ease of deployment, low maintenance cost, high-mobility and ability to hover Such vehicles 

are being utilized for real-time monitoring of road traffic, providing wireless coverage, remote sensing, search and 

rescue operations, delivery of goods, security and surveillance, precision agriculture, and civil infrastructure inspection. 

The recent research literature on UAVs focuses on vertical applications. without considering the challenges facing 

UAVs within specific vertical domains and across application domains. Consultation of topographic maps is required 

when planning large-scale and complex building projects. Construction design mistakes that are unsuitable for the 

terrain may be shown using topographic maps. Topographic maps are helpful for building projects, although they are 

frequently expensive and time demanding to produce. Drones are quite useful in these situations. Its capacity to gather 

huge volumes of data in a short length of time results in considerable cost reductions, as well as project expenses for 

these operations. Drones ensure project timeliness, budget, and accuracy owing to their capabilities.  

 

II. LITERATURE SURVEY 

Kevin W. Eliceiri et.al[1] : Image has been utilized predominantly by biologists working in a research setting, it has 

also served users from diverse non-biological research fields, including geologists and astronomers. Image is popular 

mostly in biological applications and outfield use of Image was very narrow. In his research purpose, utilises Imagej 

and mentions about the same application methodology to estimate unknown areas to a bigger scale.  

Huda M. Jawad & Tahseen A. Husain et.al [2] Implemented and developed study to find a suitable mathematical 

model in order to find an easy and accurate way to determine the object dimensions and its distance. This study was 

divided into two parts: the first one was to determine the dimensions of objects using a digital camera and a single laser 

pointer by placing those objects on black screen at different distances away from the camera then the second step was to 

determine the ranges of the objects using the images of two laser spots. Results show there is a relationship between 

different zoom and scale factor, and there is convergence and similarity between the experimental and theoretical 

values.  
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Larry Reinking et.al[3] Implemented and detailed Image software usage in biological domain, which is a powerful 

image analysis program that was created at the National Institutes of Health. Shows possibility to change application in 

different measurement acquiring fields. 

 

III. EXISTING METHODS OF SURVEY 

3.1 Surveying  

The main object of surveying is to obtain a map or a plan of the area surveyed. The art of surveying and map making 

has been practised from the very ancient times. The earliest surveys known’ were performed only for the purpose of 

establishing the boundaries of land, but their application has become increasingly important as the time has progressed. 

Now-a- days for the purpose of designing any engineering project such as a road, railway, canal, water supply or 

sanitary scheme etc., an engineer would require to study, as the very first item, the features of the earth’s surface in 

which the project is to be located, and prepare a map of that area. 

Surveys may be classified in different ways:  

According to the instrument used, such as:  

1. Chain Survey 

2. Compass Survey  

3. Theodolite Survey, etc.  

According to the purpose of Survey, such as: 

1. Mine Survey to explore the mineral wealth such as gold, copper, coal etc. 

2. Geological Survey to determine different strata in the earth’s crust.  

3. Archaeological Survey to trace customs or relics of the past. 

4. Military Survey to determine points of strategic importance.  

According to the method employed, such as:  

1. Triangulation Survey.  

2. Traverse Survey.  

According to the place of work, such as:  

1. Land Survey for objects on earth’s surface.  

2. Hydrographical or Marine Survey for objects under water.  

3. Aerial Survey by Aero plane in air. 

Land Survey can be further sub-divided into the following classes:  

1. Topographical Survey: This is used for determining the natural features of the country such as lakes, rivers, 

hills, woods and nallahs etc., and also the artificial objects such as canals, railways, roads, towns and villages 

etc. 

2. Cadastral Survey: This is usually plotted to a larger scale than topographical survey. Additional details such as 

boundaries of fields, houses and other property are determined.  

3. City Survey: This is performed in connection with town planning schemes such as drainage, water supply etc. 

and for lying out plots, roads, streets etc. 

4. Engineering Survey: This is carried out for determining the feasibility of any engineering project and 

collection of field-data as required for the design etc. 

 

3.2 Precision in Surveying 

The degree of accuracy required in survey work mainly depends upon the purpose of survey and the scale of plotting. 

Since the land in cities and towns is much more valuable than that in rural areas, so greater accuracy is required in the 

survey of urban areas and measurements must be made up to the nearest centimeter. But in the survey of fields, 

measuring up to smaller fractions is sheer wastage of time. They may be taken to the nearest decimeter. At the same 

time, it may be pointed out that very accurate surveys take much time and are more expensive. 

Summing up the various factors, the accuracy required in survey-work depends upon the following:  

1. The purpose of the survey,  

2. The nature and size of the country to be surveyed,  
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3. The instruments and methods of observation employed,

4. The sources of error, 

5. The funds available,  

6. The time available  

7. The scale used for plotting 

Keeping in view the above factors, the surveyor may decide upon the method and instruments most suitable for 

particular case. By properly planning and methodically conducting the sur

accuracy at a minimum cost and in a minimum time. When comparing with aerial drone survey, existing methods needs 

innovation to produce data output quickly, easily, more reliable and accurate. Existing survey 

human resources and is cost demanding. Areas where using existing methods of survey is hazardous to human 

resources in places such as land slide terrains, flood regions etc….can be easily accessed by aerial drone survey system.

 

IV. 

4.1 Concept of Indirect Measurement

 Indirect measurement is a method of using proportions to find an unknown length or distance in similar figures. when 

using indirect measurement method, at least any one of parameter should be kno

collecting unknown geometric data that is the unknown base length. Height is obtained from the drone’s altitude sensor 

and increase in height is proportional to increase in area coverage which is base length. Each dot menti

length is the number of pixels covered in image at respective height.

 

4.2 Pixel Theory 

Pixel, short for picture element, is the smallest unit in a graphic display or digital image. Computer displays are made

up of a grid of pixels. Each pixel is made up of

combinations and intensities to make millions of different colours. a "physical" pixel is

(short for 'picture element') is a tiny square of colour. Lots of these pixels together can form a digital image. Each pixel 

has a specific number and this number tells the computer what colour the pixel should be.

takes an image and turns it into a set of pixels. A group of a pixel with its coordinate data are compared with a known 

reference distance data in the same picture itself. If an image covering base length distance of respective height, data 

can be taken out from it by known parameters su
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The instruments and methods of observation employed, 

Keeping in view the above factors, the surveyor may decide upon the method and instruments most suitable for 

particular case. By properly planning and methodically conducting the survey-work, he can attain the required degree of 

accuracy at a minimum cost and in a minimum time. When comparing with aerial drone survey, existing methods needs 

innovation to produce data output quickly, easily, more reliable and accurate. Existing survey 

human resources and is cost demanding. Areas where using existing methods of survey is hazardous to human 

resources in places such as land slide terrains, flood regions etc….can be easily accessed by aerial drone survey system.

IV. THEORY AND FUNDAMENTALS 

4.1 Concept of Indirect Measurement 

Indirect measurement is a method of using proportions to find an unknown length or distance in similar figures. when 

using indirect measurement method, at least any one of parameter should be known. Aerial drone survey is about 

collecting unknown geometric data that is the unknown base length. Height is obtained from the drone’s altitude sensor 

and increase in height is proportional to increase in area coverage which is base length. Each dot menti

length is the number of pixels covered in image at respective height. 

 
Figure 4.1: Indirect measurement 

Pixel, short for picture element, is the smallest unit in a graphic display or digital image. Computer displays are made

up of a grid of pixels. Each pixel is made up of red, blue, and green lighting elements

combinations and intensities to make millions of different colours. a "physical" pixel is 1⁄96 inch (0.26 mm). A 'pixel' 

element') is a tiny square of colour. Lots of these pixels together can form a digital image. Each pixel 

has a specific number and this number tells the computer what colour the pixel should be. The process of digitization 

a set of pixels. A group of a pixel with its coordinate data are compared with a known 

reference distance data in the same picture itself. If an image covering base length distance of respective height, data 

can be taken out from it by known parameters such as known height and number of pixels covered by the image.
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Keeping in view the above factors, the surveyor may decide upon the method and instruments most suitable for 

work, he can attain the required degree of 

accuracy at a minimum cost and in a minimum time. When comparing with aerial drone survey, existing methods needs 

innovation to produce data output quickly, easily, more reliable and accurate. Existing survey methods require more 

human resources and is cost demanding. Areas where using existing methods of survey is hazardous to human 

resources in places such as land slide terrains, flood regions etc….can be easily accessed by aerial drone survey system. 

Indirect measurement is a method of using proportions to find an unknown length or distance in similar figures. when 

wn. Aerial drone survey is about 

collecting unknown geometric data that is the unknown base length. Height is obtained from the drone’s altitude sensor 

and increase in height is proportional to increase in area coverage which is base length. Each dot mentioned at base 

Pixel, short for picture element, is the smallest unit in a graphic display or digital image. Computer displays are made 

red, blue, and green lighting elements that are used in different 

⁄96 inch (0.26 mm). A 'pixel' 

element') is a tiny square of colour. Lots of these pixels together can form a digital image. Each pixel 

The process of digitization 

a set of pixels. A group of a pixel with its coordinate data are compared with a known 

reference distance data in the same picture itself. If an image covering base length distance of respective height, data 

ch as known height and number of pixels covered by the image. 
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Figure 4.2: Pixel basics 

 

V. TOOLS AND TECHNOLOGY 

5.1 Drone  

In our project we have used Dji mavic air Drone. The Mavic Air, which was released in early 2018 can capture 4k 

video at 30 FPS. The Air has a 3-axis gimbal and 24mm lens. The Air also has a Smart Capture feature, a three-

directional environment sensing system and a max flight time of 21 minutes. It features a 12 MP 4K HDR camera, 

mounted on a 3-axis gimbal, and has a new panorama mode, which stitches together 25 photos in eight seconds to 

create a "Sphere Panorama". Due to antennas mounted on its landing gear, the drone has a 21-minute flight time and a 

2.5-mile range. Like the Spark, the Air also features the "Smart Capture" mode, in which the drone can be controlled by 

hand gestures. 

 
Figure 5.1: Dji mavic (flight hovering) 

Sensor 1/2.3” CMOS Effective Pixels: 12 MP 

Lens FOV: 85° 35 mm Format Equivalent: 24 mm

Aperture: f/2.8 Shooting Range: 0.5 m to ∞ 

Angular Vibration Range ±0.005° 

Maximum Take-off Altitude 5000 m 
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5.2 Hardware Requirements  

A. Processor Intel Core i3 – 3220 (3.3 GHZ) 

An Intel Corei3 is an Intel proprietary processor that is built on the framework of multiprocessor architecture. It is a 

type of dual-core processor with an integrated graphic processing unit (GPU). It is a successor of the Core 2 series of 

processors produced by Intel.  

 

B. RAM 4 GB  

RAM stands for random-access memory, RAM is essentially short term memory where data is stored as the processor 

needs it. This isn't to be confused with long

computer is turned off. 4 GB RAM is used for this app development. 

 

C. Storage 512 GB  

A 512 GB SSD is enough space for laptops. It offers enough speed and storage space. 

 

D. Keyboard and Mouse  

The keyboard allows type letters and numbers and the 

program functions by clicking mouse button

 

5.3 Image (version 1.38) 

Image is a public domain Java image processing program inspired by

online applet or as a downloadable application, on any computer with a Java 1.4 or later virtual machine. Downloadable 

distributions are available for Windows, Mac OS, Mac OS X and Linux. 

print 8-bit, 16-bit and 32-bit images. It can read many image formats including TIFF, GIF, JPEG, BMP, DICOM, FITS 

and "raw". It supports "stacks", a series of images that s

operations such as image file reading can be performed in parallel with other operations.

It can calculate area and pixel value statistics of user

create density histograms and line profile plots. It supports standard image processing functions such as contrast 

manipulation, sharpening, smoothing, edge detection and median filtering. It does geometric transformations such as 

scaling, rotation and flips. Image can be zoomed up to 32:1 and down to 1:32. All analysis and processing functions are 

available at any magnification factor. The program supports any number of windows (images) simultaneously, limited 

only by available memory. 
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3220 (3.3 GHZ)  

An Intel Corei3 is an Intel proprietary processor that is built on the framework of multiprocessor architecture. It is a 

core processor with an integrated graphic processing unit (GPU). It is a successor of the Core 2 series of 

access memory, RAM is essentially short term memory where data is stored as the processor 

needs it. This isn't to be confused with long-term data that's stored on hard drive, which stays there even when t

computer is turned off. 4 GB RAM is used for this app development.  

A 512 GB SSD is enough space for laptops. It offers enough speed and storage space.  

The keyboard allows type letters and numbers and the mouse allows the user to position the cursor, draw and execute 

program functions by clicking mouse button 

Image is a public domain Java image processing program inspired by NIH Image for the Macintosh. It runs, either as an 

online applet or as a downloadable application, on any computer with a Java 1.4 or later virtual machine. Downloadable 

ndows, Mac OS, Mac OS X and Linux. It can display, edit, analyze, process, save and 

bit images. It can read many image formats including TIFF, GIF, JPEG, BMP, DICOM, FITS 

and "raw". It supports "stacks", a series of images that share a single window. It is multithreaded, so time

operations such as image file reading can be performed in parallel with other operations. 

It can calculate area and pixel value statistics of user-defined selections. It can measure distances and

create density histograms and line profile plots. It supports standard image processing functions such as contrast 

manipulation, sharpening, smoothing, edge detection and median filtering. It does geometric transformations such as 

rotation and flips. Image can be zoomed up to 32:1 and down to 1:32. All analysis and processing functions are 

available at any magnification factor. The program supports any number of windows (images) simultaneously, limited 

Figure 5.2: ImageJ Interface 
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An Intel Corei3 is an Intel proprietary processor that is built on the framework of multiprocessor architecture. It is a 

core processor with an integrated graphic processing unit (GPU). It is a successor of the Core 2 series of 

access memory, RAM is essentially short term memory where data is stored as the processor 

term data that's stored on hard drive, which stays there even when the 

mouse allows the user to position the cursor, draw and execute 

for the Macintosh. It runs, either as an 

online applet or as a downloadable application, on any computer with a Java 1.4 or later virtual machine. Downloadable 

It can display, edit, analyze, process, save and 

bit images. It can read many image formats including TIFF, GIF, JPEG, BMP, DICOM, FITS 

hare a single window. It is multithreaded, so time-consuming 

defined selections. It can measure distances and angles. It can 

create density histograms and line profile plots. It supports standard image processing functions such as contrast 

manipulation, sharpening, smoothing, edge detection and median filtering. It does geometric transformations such as 

rotation and flips. Image can be zoomed up to 32:1 and down to 1:32. All analysis and processing functions are 

available at any magnification factor. The program supports any number of windows (images) simultaneously, limited 
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Spatial calibration is available to provide real world dimensional measurements in units such as millimeters. Density or 

Gray scale calibration is also available. Image was designed with an open architecture that provides extensibility via 

Java plugins. Custom acquisition, analysis and processing plugins can be developed using Image's built in editor and 

Java compiler. User-written plugins make it possible to solve almost any image processing or analysis problem. ImageJ 

is a powerful image analysis program that was created at the National Institutes of Health. It is in the public domain, 

runs on a variety of operating systems. 

1. Image Window: The ImageJ window will appear on the desktop. Note that this window has a Menu Bar, a 

Tool Bar and a Status Bar. 

2. Opening an Image File: Select File→Open from the menu bar to open a stored image file. 

3. Tool Bar: The various buttons on the tool bar allow you measure, draw, label, fill, etc. A right click or a 

double left-click may expand your options with some of the tool buttons. 

4. Area Selection Tools: The first four buttons on the tool bar allow you to surround an area on the image with a 

rectangle, oval, polygon or freehand shape. After selection, these areas may be altered, analysed, copied, etc. 

using the menu commands. Note that the status bar, below the tool bar, gives information such as the 

coordinates (xx, yy) of the selection on the frame. 

5. Line Selection Tools: This button allows you to create straight, segmented or freehand lines (right-click to 

select line type). Information about the line is displayed on the status bar. Double-click on the button to alter 

the line width, select Analyse→Measure (or Ctrl+M) to record a line length and Edit → Draw (or Ctrl+D) to 

make a line permanent. 

6. Angle Tool: Draws two intersecting lines and measures the formed angle. 

7. Point Tool: When ‘Auto-Measure’ is selected, this tool allows you to mark locations on an image; with each 

click the coordinates of the mark (xx, yy) and brightness values (0-255) are recorded in a data window. Colour 

images will have three brightness readings displayed on the status bar, one each for the red, green and blue 

channels, however only a single grey scale brightness value will appear in the data window. 

8. Wand Tool: This tool automatically finds the edge of an object and traces its shape. It works best with high 

contrast images .Place the wand to the left of an edge; click and the algorithm will search to the right for an 

edge. It will then trace along the edge of the object until it returns to the starting point. 

9. Magnifying Glass: Left-click on the image to magnify; right-click to reduce the image size. 

10. Scrolling Tool: This button allows you to move an image if it is larger than the window. Pressing the 

keyboard space bar is a shortcut that temporarily activates this tool.      

11. Measuring and Counting Objects: Setting Measurement Scale. Draw a line between two points of known 

distance such as a ruler on the photograph. Go to Analyze→ Set Scale. In the Set Scale window, the length of 

the line, in pixels, will be displayed. Type the known distance and units of measure in the appropriate boxes 

and click OK. Measurements will now be shown using these settings. If the pixel-length relationship is known 

from a previous measurement you may directly type this information in the Set Scale window. Check 'global' 

to apply this scale to other image frames. Set Measurements. Choose parameters to be measured via Analyze 

→Set Measurements. Measuring Distance Between Points. Draw a line between two points. The status bar will 

show the angle (from horizontal) and the length. Analyze→Measure (or Ctrl+M) transfers the values to a data 

window. Measuring Area. Surround an area with a perimeter. This can be done with an area selection tool, the 

wand (for high contrast images) or with Analyze Particles. Analyze→Measure (or keyboard M) transfers the 

area measurement to a data window. Counting Particles. As described above, convert the image to 8-bit 

grayscale and then 'threshold' the image. Go to Analyze→Analyze Particles, type the upper and lower limits 

for the particle size, toggle 'show outlines' and check ‘Display Results’. Click OK and each counted particle 

will be outlined and numbered in a new widow (numbers may be very small). The data window contains 

measurements for each particle. 

12. Saving Files: Images from digital cameras are usually saved as JPEG files. JPEG is a type of memory 

compression that results in the loss of some data. A JPEG image degrades each time it is opened, edited and 

resaved. It is best to save a file in a 'lossless' format such as a TIFF during the editing process (File→Save 

As→Tiff). 
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5.4 Reference Plate 

Aerial Drone Survey requires a reference plate. A Refe

having a dimension of 50cm*50cm and an area of 2500cm

from heights. For our project we will be placing two reference board in different colour. The distance Between the two

coloured reference plate is measured and taken as 3 meters. 
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Figure 5.2: Graphical representation of performed reference plate alignment.

 

We are implementing this project to survey and access threatening terrains, land slide areas, flooded regions, etc…to 

get a reliable and precise set of data measurements. To measure the area or to get an output our project aerial drone 

survey contains a series of steps to be followed. 

 

A. Drone take off from ground level with reference aligned on the ground:

This is the first step in acquiring image data. The drone is initiated with communication setup connections between base 

station and drone. From a region where drone is safe to take off, placed with a reference plate (50cm*50cm) aligned 
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Aerial Drone Survey requires a reference plate. A Reference plate is called a plate with known measurements which is 

having a dimension of 50cm*50cm and an area of 2500cm2. The plate is also having a visible and identifiable colour 

from heights. For our project we will be placing two reference board in different colour. The distance Between the two

coloured reference plate is measured and taken as 3 meters.  

Figure 5.1: Reference plate aligned on ground. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

raphical representation of performed reference plate alignment.

VI. METHODOLOGIES 

We are implementing this project to survey and access threatening terrains, land slide areas, flooded regions, etc…to 

get a reliable and precise set of data measurements. To measure the area or to get an output our project aerial drone 

ries of steps to be followed.  

A. Drone take off from ground level with reference aligned on the ground: 

This is the first step in acquiring image data. The drone is initiated with communication setup connections between base 

ion where drone is safe to take off, placed with a reference plate (50cm*50cm) aligned 
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nce plate is called a plate with known measurements which is 

plate is also having a visible and identifiable colour 

from heights. For our project we will be placing two reference board in different colour. The distance Between the two-

raphical representation of performed reference plate alignment. 

We are implementing this project to survey and access threatening terrains, land slide areas, flooded regions, etc…to 

get a reliable and precise set of data measurements. To measure the area or to get an output our project aerial drone 

This is the first step in acquiring image data. The drone is initiated with communication setup connections between base 

ion where drone is safe to take off, placed with a reference plate (50cm*50cm) aligned 
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horizontally on the ground. The drone will be taking flight perpendicular to the reference board to ensure more 

coverage with reference plate in centre. While before tak

Fig

 

B. Fixing drone at a stable height to capture images:

Once the drone is take-off vertically from the reference plate to particular height

horizontally, that particular height is made to be fixed throughout the entire process. The height is kept stable 

throughout because to get uniformity while applicating indirect trigonometric measurement function. When t

of drone increases the area of coverage also increases thus makes possible to cover more area. Multiple images taken at 

same height will have same pixel distribution. The image with reference and image without reference can be calculated 

even only when the two images are captured at same height. For our experiment to get wider area coverage we 

managed to capture image at 250 feet height.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.2: 

IJARSCT  
   

International Journal of Advanced Research in Science, Communication and

 Volume 2, Issue 1, November 2022 
 

              DOI: 10.48175/IJARSCT-7337 

horizontally on the ground. The drone will be taking flight perpendicular to the reference board to ensure more 

coverage with reference plate in centre. While before take-off the operator should make concern about safety.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.1 Drone take-off from reference plate 

B. Fixing drone at a stable height to capture images: 

off vertically from the reference plate to particular height which is safe for the drone to fly 

horizontally, that particular height is made to be fixed throughout the entire process. The height is kept stable 

throughout because to get uniformity while applicating indirect trigonometric measurement function. When t

of drone increases the area of coverage also increases thus makes possible to cover more area. Multiple images taken at 

same height will have same pixel distribution. The image with reference and image without reference can be calculated 

y when the two images are captured at same height. For our experiment to get wider area coverage we 

managed to capture image at 250 feet height. 

Figure 6.2: View of ground chosen for experiment 
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horizontally on the ground. The drone will be taking flight perpendicular to the reference board to ensure more 

off the operator should make concern about safety. 

which is safe for the drone to fly 

horizontally, that particular height is made to be fixed throughout the entire process. The height is kept stable 

throughout because to get uniformity while applicating indirect trigonometric measurement function. When the height 

of drone increases the area of coverage also increases thus makes possible to cover more area. Multiple images taken at 

same height will have same pixel distribution. The image with reference and image without reference can be calculated 

y when the two images are captured at same height. For our experiment to get wider area coverage we 
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C. Image acquiring and transmitting to a base station 

Capturing the image by using the drone and instantly receiving to the base station. A base station is a controller of 

drone itself which can be connected along with a mobile phone or a laptop for checking the visual during the flight 

time. The image will be stored in the external memory of the drone also as a backup. Image can be taken out even in 

live secession or after flight from the external memory storage inside the drone. 

  

 

 

 

 

 

 

 

 

 

 

 

Figure 6.3: Receiver controller 

 
Figure 6.4: Acquired data image 1 

Figure 6.5: Acquired data image 2 
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D. Importing image to Image 

The image captured in drone will be shared to the local storage of a laptop. Open Image software

menu bar-then select open. Choose the appropriate ima

 

 

  

  

 

 

 

 

 

 

 

 

 

 

 

E. Processing using Image 

 It is the important step in aerial drone survey. Our aim is to measure the area from the image. Once when the 

appropriate image is chosen the next step is to select the selection tool from the tool bar. In our case we have chosen the 

image of our college ground along with reference aligned with a known distance of 3meter between the red and grey 

coloured reference plate. The next step is to set scale by calibrating with a known distance. We have two known 

distance one is the distance between plates and the

calibrate draw a line by zooming the red or grey coloured reference plate along its edge to edge. The next step is to run 

the analyze option for determining the number of pixels covered in the se

menu itself, select the set scale option as it shows the number of pixels covered in which the area, we have selected 

from the grey colour reference board.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.7:
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The image captured in drone will be shared to the local storage of a laptop. Open Image software

then select open. Choose the appropriate image from list. The image will now appear on the screen. 

Figure 6.6: Image importing 

It is the important step in aerial drone survey. Our aim is to measure the area from the image. Once when the 

appropriate image is chosen the next step is to select the selection tool from the tool bar. In our case we have chosen the 

ground along with reference aligned with a known distance of 3meter between the red and grey 

coloured reference plate. The next step is to set scale by calibrating with a known distance. We have two known 

distance one is the distance between plates and the other is dimension of reference plate that is 50cm*50cm. To 

calibrate draw a line by zooming the red or grey coloured reference plate along its edge to edge. The next step is to run 

the analyze option for determining the number of pixels covered in the selected area selected area. From the analyse 

menu itself, select the set scale option as it shows the number of pixels covered in which the area, we have selected 

6.7: Graphical representation of pixel to image ratio 
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The image captured in drone will be shared to the local storage of a laptop. Open Image software-select file from the 

ge from list. The image will now appear on the screen.  

It is the important step in aerial drone survey. Our aim is to measure the area from the image. Once when the 

appropriate image is chosen the next step is to select the selection tool from the tool bar. In our case we have chosen the 

ground along with reference aligned with a known distance of 3meter between the red and grey 

coloured reference plate. The next step is to set scale by calibrating with a known distance. We have two known 

other is dimension of reference plate that is 50cm*50cm. To 

calibrate draw a line by zooming the red or grey coloured reference plate along its edge to edge. The next step is to run 

lected area selected area. From the analyse 

menu itself, select the set scale option as it shows the number of pixels covered in which the area, we have selected 
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Figure 6.8: 

 

F. Output Result 

Output result is obtained by processing of Multiplying the pixels covered in the selected area with a pre

value of pixel. (processed pixel value). Hence Obtaining parameters such as area, the distance.

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 6.9: Obtained result of our college ground after experiment (in cm)
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Figure 6.8: Calibrating with reference plate 

Output result is obtained by processing of Multiplying the pixels covered in the selected area with a pre

(processed pixel value). Hence Obtaining parameters such as area, the distance.

btained result of our college ground after experiment (in cm)

 ISSN (Online) 2581-9429 

  

, Communication and Technology (IJARSCT) 

 49 

Output result is obtained by processing of Multiplying the pixels covered in the selected area with a pre-determined 

(processed pixel value). Hence Obtaining parameters such as area, the distance. 

btained result of our college ground after experiment (in cm) 
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Figure 6.

 

We have developed a system for aerial survey purposes and it can access threatening terrains, land slide areas, flooded 

regions, etc…to get a reliable, fast and precise set of data measurements. The other methodology for geometric 

measurements uses complex and expensive sensors which require skilled technicians to operate and interpret for data. 

With this system we could obtain set of data output with less than one percentage error when performed. 
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Figure 6.10: ADS (Aerial Drone Survey) Interface 

VII. RESULT AND DISCUSSION 

We have developed a system for aerial survey purposes and it can access threatening terrains, land slide areas, flooded 

regions, etc…to get a reliable, fast and precise set of data measurements. The other methodology for geometric 

uses complex and expensive sensors which require skilled technicians to operate and interpret for data. 

With this system we could obtain set of data output with less than one percentage error when performed. 

Figure 7.1: Result output data (in cm) 
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We have developed a system for aerial survey purposes and it can access threatening terrains, land slide areas, flooded 

regions, etc…to get a reliable, fast and precise set of data measurements. The other methodology for geometric 

uses complex and expensive sensors which require skilled technicians to operate and interpret for data. 

With this system we could obtain set of data output with less than one percentage error when performed.  
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Aerial drone survey project focuses on fast and reliable indirect measurement where a drone can easily deploy and get 

measurement sets without safety constrains. By implementing this project, it will be an alternate solution to cost 

demanding surveys, use of fuel consuming aerial vehicles such as helicopters and aeroplanes for the purpose of survey 

can be replaced with aerial drone survey system. 

1. AI incorporated with aerial drone surveys could make the automated taking of parameters 

accessible. 

2. Industrial area pre-planning.  

3. Image distance interpretation in future vehicles.

4. Land management and development also Urban planning.

5. Industrial part production incorporated with vision system having measurements analysis more 
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Figure 7.2: Performed experiment 

VIII. CONCLUSION 

Aerial drone survey project focuses on fast and reliable indirect measurement where a drone can easily deploy and get 

measurement sets without safety constrains. By implementing this project, it will be an alternate solution to cost 

of fuel consuming aerial vehicles such as helicopters and aeroplanes for the purpose of survey 

can be replaced with aerial drone survey system.  

 

IX. FUTURE SCOPE 

AI incorporated with aerial drone surveys could make the automated taking of parameters 

Image distance interpretation in future vehicles. 

Land management and development also Urban planning. 

Industrial part production incorporated with vision system having measurements analysis more 
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Aerial drone survey project focuses on fast and reliable indirect measurement where a drone can easily deploy and get 

measurement sets without safety constrains. By implementing this project, it will be an alternate solution to cost 

of fuel consuming aerial vehicles such as helicopters and aeroplanes for the purpose of survey 

AI incorporated with aerial drone surveys could make the automated taking of parameters easier and more 

Industrial part production incorporated with vision system having measurements analysis more accurate. 
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